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Value-Added Reseller (VAR) Language 

Oracle Retail VAR Applications 
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applications) licensed to Oracle. Depending upon your product and its version number, the VAR 
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Send Us Your Comments 
Oracle Retail Macro Space Management, Configuration Module User Guide, Release 14.1 

 

Oracle welcomes customers' comments and suggestions on the quality and usefulness of 
this document. 

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example: 

 Are the implementation steps correct and complete? 

 Did you understand the context of the procedures? 

 Did you find any errors in the information? 

 Does the structure of the information help you with your tasks? 

 Do you need different information or graphics? If so, where, and in what format? 

 Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us 
your name, the name of the company who has licensed our products, the title and part 
number of the documentation and the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to 
check that you have the latest version of the document and if 
any concerns are already addressed. To do this, access the 
Online Documentation available on the Oracle Technology 
Network Web site. It contains the most current 
Documentation Library plus all documents revised or 
released recently. 

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com 

Please give your name, address, electronic mail address, and telephone number 
(optional). 

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services.  

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at www.oracle.com. 

http://www.oracle.com/
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Preface 
This guide describes the Macro Space Management user interface. It provides step-by-
step instructions to complete most tasks that can be performed through the user 
interface. 

Audience 
This User Guide is for users and administrators of Oracle Retail Macro Space 
Management. This includes merchandisers, buyers, business analysts, and administrative 
personnel. 

Documentation Accessibility 
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.  

Access to Oracle Support 
Oracle customers that have purchased support have access to electronic support through 
My Oracle Support.  For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired. 

Related Documents 
For more information, see the following documents: 
 Oracle Retail Macro Space Management Release Notes 

 Oracle Retail Macro Space Management Administration Module User Guide 

 Oracle Retail Macro Space Management Configuration Module User Guide 

 Oracle Retail Macro Space Management Data Importer User Guide 

 Oracle Retail Macro Space Management Fixture Studio User Guide 

 Oracle Retail Macro Space Management Product Studio User Guide 

 Oracle Retail Macro Space Management Report Designer User Guide 
 Oracle Retail Macro Space Management Merchandiser User Guide 

 Oracle Retail Macro Space Management Planner User Guide 

 Oracle Retail In-Store Space Collaboration Release Notes 

 Oracle Retail In-Store Space Collaboration User Guide 

 Oracle Retail In-Store Space Collaboration Mobile User Guide 

 Oracle Retail Macro Space Planning Installation Guide 

 Oracle Retail Macro Space Planning Data Model  

 Oracle Retail Macro Space Planning Security Guide 

  

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
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Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 

https://support.oracle.com 

When contacting Customer Support, please provide the following: 

 Product version and program/module name 

 Functional and technical description of the problem (include business impact) 

 Detailed step-by-step instructions to re-create 

 Exact error message received 

 Screen shots of each step you take 

Review Patch Documentation 
When you install the application for the first time, you install either a base release (for 
example, 14.1) or a later patch release (for example, 14.1.1). If you are installing the base 
release or additional patch releases, read the documentation for all releases that have 
occurred since the base release before you begin installation. Documentation for patch 
releases can contain critical information related to the base release, as well as information 
about code changes since the base release. 

Improved Process for Oracle Retail Documentation Corrections 
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in the 
case of Data Models, to the applicable My Oracle Support Documentation container 
where they reside. 

This process will prevent delays in making critical corrections available to customers. For 
the customer, it means that before you begin installation, you must verify that you have 
the most recent version of the Oracle Retail documentation set. Oracle Retail 
documentation is available on the Oracle Technology Network at the following URL: 
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html 

An updated version of the applicable Oracle Retail document is indicated by Oracle part 
number, as well  as print date (month and year). An updated version uses the same part 
number, with a higher-numbered suffix. For example, part number E123456-02 is an 
updated version of a document with part number E123456-01. 

If a more recent version of a document is available, that version supersedes all previous 
versions. 

Oracle Retail Documentation on the Oracle Technology Network 
Documentation is packaged with each Oracle Retail product release. Oracle Retail 
product documentation is also available on the following Web site: 
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html 

(Data Model documents are not available through Oracle Technology Network. These 
documents are packaged with released code, or you can obtain them through My Oracle 
Support.) 

Documentation should be available on this Web site within a month after a product 
release. 

https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html


 Conventions 

xiii 

Conventions 
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure 
and ends with a screen shot of the starting point and the statement “the Window Name 
window opens.”  
This is a code sample 
 It is used to display examples of code 
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1 
About the Configuration Module 

About the Configuration Module 
The Configuration Module allows numerous aspects of the operation of Macro Space 
Management to be customized to suit individual users. It also allows directory paths and 
file paths to be specified. Depending on where the Configuration Module is opened from, 
it will display differing numbers of tabs. If opened from the Administration module, it 
will show the full range of tabs. 

 

If opened from the Fixture Studio, Product Studio, Planner or Merchandiser modules, a 
more restricted set of tabs will be available. 
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The majority of the tabs available only from the Administration Module control global 
operation of Macro Space Planning - for example the directories tab specifies where data 
files are to be stored. The tabs accessible from all modules are concerned with user 
specific settings - for example the Zones tab can be used specify how zones will highlight 
in the floor plan when selected in the zone hierarchy in the Object Browser. 

Accessing the Configuration Module 
There are two methods of accessing the Configuration Module - from the menu bar in 
most modules and from the toolbars on the Object Browser in the Planner and 
Merchandiser Modules. 

From the Menu Bars 
Opening multiple tabs of the Configuration Module can be accomplished from the File 
menu of the Administration, Fixture Studio, Product Studio, Planner or Merchandiser 
modules. 

Note: If opened from within the Administration Module, 
configuration can only be opened when all other dialog 
boxes are closed. 
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Note: the full range of tabs in the Configuration Module will 
only be available if opened from the Administration module. 

From the Object Browser Toolbar 
An alternative way of opening the Configuration module is from the Options button on 
the toolbar of the Object Browser. These icons have different appearances in the Planner 
and Merchandiser modules. 

 Planner Module 

 
 Merchandiser Module 

 
This will bring up the pertinent tab of the Configuration module. 
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The tabs that can be brought up in this way are the Zones tab, the Fixturing tab and the 
Merchandising tab. 

Making Changes in the Configuration Module 
If making these changes in the Configuration Module in the Directories or Files tabs, it is 
recommended that all modules are closed with the exception of the Administration 
Module. The Configuration module can then be called from the Administration module. 

Global Effects 
Some changes in the configuration module have global effects. These are: 

Options Tab 
This can affect the units used and the precision with which those units can be displayed. 

Directory Paths 
Changes to the directory paths will affect all users for a specific database. Before making 
changes to the paths, the consequences of these changes should be determined. It is also 
recommended that all users of that database be asked to log out before the directory 
paths are changed. When they log in again, all users will then be using the revised paths. 

Files 
The file most often changed is the AutoCAD template drawing used as the basis for all 
blank floor plans created within Store Manager. At present, this information is stored in 
the registry. Accordingly, in order to change the information as to where the file is 
located, an administrator must log onto each local machine in turn and change the 
information in the Files tab of the Configuration Module. 
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Information Stored in the Registry 
Some information set in the Configuration Module is stored in the registry. This can be in 
two forms. 

Changes affecting all Users of a Specific Computer 
Some of the settings in the Configuration Module are stored in the registry. These 
settings affect all users of Macro Space Management using that particular computer. 

Changes Affecting Individual Users of MSM 
Some other settings in the Configuration Module are stored in the registry. These settings 
only affect that specific MSM user. 

Note: for more information on how specific values in the 
registry are used by MSM contact Oracle's Technical Support 
Department. 

When Changes take Effect 
Changes made in the Configuration Module will only be written to the database when 
the OK button in the lower right of the Configuration Module dialogue box is clicked. 
(Clicking the Cancel button will exit without saving changes).   

 
If the user makes changes in the Configuration Module, then exits without saving, they 
will be warned about outstanding changes. 

 
Changes made to settings within the Configuration Module will take effect at different 
times. Some settings will have an immediate local effect. Other changes will take effect 
when a new store plan is opened. Other changes will only take effect when Macro Space 
Management is restarted. 

Configuration Module Components 
The Configuration Module contains a series of tabs. Each tab allows changes to be made 
to a specific aspect of Macro Space Management operation. 
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The tabs are as follows: 

Tab Description 

Options Tab This allows some details of the interface with the software to be configured. 

Directories Tab 
This allows the directories where Macro Space Management stores data and 
files to be specified. 

Files Tab  
This enables the user to specify where the DWG file used as a template for new 
floor plans in Planner is located. 

Zones Tab This allows the way Zones are displayed to be specified. 

Fixturing Tab This enables the way fixtures are inserted into the store plan to be configured. 

Merchandising 
Tab 

This enables the way Products and Planograms are selected and displayed to be 
adjusted. 

Merchandiser 
Tab 

This allows the way Merchandiser displays a virtual store to be configured. 

Profiles Tab This allows the adding, editing, renaming and deleting of profiles. These store 
connection details.  

The Options, Directories, Files and Profiles tabs are only available if the Configuration 
module is opened from the Administration module. 
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The Options Tab 

The Options Tab 
The Options Tab enables a number of broad options to be set up. It is only available to 
users who have accessed the Configuration Module via the Administration module. 

 
The Units frame allows the user to specify which units Macro Space Management will 
use as its default. 

Option Description 

Units These can be set to either Metric or Imperial using the radio button. They 
should be appropriate for the database in use. 

Fixture Decimal 
Precision This is the precision that will be used for dimensions in Fixture Studio. 

Fixture Numeric 
Increment 

This is the amount a spin control in Fixture Studio will be incremented each 
time the user clicks on an increase or decrease arrow. 

Product Decimal 
Precision This is the precision that will be used for dimensions in Product Studio. 

Product Numeric 
Increment 

This is the amount a spin control in Product Studio will be incremented each 
time the user clicks on an increase or decrease arrow. 
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Note: Fixture Decimal Precision, Fixture Numeric Increment, 
Product Decimal Precision and Product Numeric Increment 
are currently not functional. 

Although Macro Space Management can work in a variety of units, specifying the default 
unit affects some aspects of configuration including the units used for the default 
tolerances and for annotation. The default unit is also the measure used to store 
measurements in the database. 
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3 
Directories Tab 

The Directories Tab 
The Directories Tab contains the list of Directories where Macro Space Management 
stores its information. It is only available to users who have accessed the Configuration 
Module via the Administration module. 

 

Making Changes 
Changes to the directory paths will affect all users for a specific database. Before making 
changes to the paths, the consequences of these changes should be determined. It is also 
recommended that all users of that database be asked to log out before the directory 
paths are changed. When they log in again, all users will then be using the revised paths. 

Configuring Directories 

Directory Types 
These directories may be: 

 Default: mandatory directories required by the software and defined by Oracle. 
These cannot be renamed or deleted. 

 User Defined: non-mandatory directories defined by the user and used to hold 
information on (for example) fixtures. These can be added to meet customer 
requirements. 
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Directory Locations 
These directories may be located as follows: 

 Central: in a single specific location on a network so that the data in them is available 
for all users  

 Local: in a location specific to the user (often on their hard drive) and normally only 
accessible to that user 

Directory Paths 
The path to the directory may be specified as either a: 

 Mapped drive: the path name is relative to a folder that has been 'mapped' using 
Windows tools  

 UNC (Uniform Naming Convention) path: the full path to the directory 

 Local Drive: the user's local hard drive 

Note: the directories referenced by In-Store Space 
Collaboration must always be UNC paths - the ISSC service 
does not recognize mapped drives. 

Information on directory paths may be stored as: 

 Default: the standard path to the directory used as the default for all users.    

 User Specific: a path to the directory specific to that user. User specific paths can only 
be set for user defined directories and not for system directories. 

Note: UNC paths are better for Central paths. This is because 
not everyone will have mapped to the same directory, 
whereas a UNC path is common to all users. 

The Directories Tab enables Administrators to configure this information. 

Overview of Directories 
The default directories for Macro Space Management are specified below. They are 
configured by Oracle and cannot be deleted or renamed. 

 Network Directories use a single specific location on a network so that the data in 
them is available for all users. 

 Local Directories use a location specific to the user (usually on their hard drive) and 
normally only accessible to that user. 

Directories should only be designated as Local if there is no possibility of the specific 
data stored there being used by other users. 
  

Directory 
Name 

Directory 
Type 

Comment 

Archived 
Files 

Network Directory files will be moved to after they have been imported. 

BMP Preferably 
local 

This directory is used for the AutoCAD toolbar button bitmaps that 
appear in the toolbars in the Planner environment. It is normally 
local as the icons are part of the software installation. The local files 
are found at C:\Oracle Retail\MSM\BMP. 
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Directory 
Name 

Directory 
Type 

Comment 

Export files Network 
or local 

Location that files are exported to, for example snapshots ( images) 
exported from the Merchandiser module. 

Icons Network 
or local 

Directory for additional icons used by Oracle Retail Macro Space 
Management. This directory will be discontinued shortly. 

Floor Plan 
Publish 

Network Directory which acts as the root for the location floor plans are 
published to. The file structure below this root is dependent on 
settings in the Floor Plan Publishing configuration dialog box 
accessed from the File menu in the Administration Module. 

Image 
Capture 

Network Default directory for holding images captured by a scanner, digital 
camera, etc. These images can subsequently be imported into the 
software. 

Image Label Network Directory for images that can be added to the labels associated with 
fixtures in the Merchandiser environment. 

Image 
Profile 

Network Location for 2D planogram profile images. The images are used 
when a planogram is placed as a 2D placeholder in the 
Merchandiser environment. 

Image Root Network This is the root directory for the images that will be used for photo-
realistic indications of products. As product images are added, 
edited or deleted, the hierarchy below the image root will be 
modified.  

Note: Image Root must be a UNC path if referenced by In-
Store Space Collaboration. 

Import Files Network Location to which files will be imported. Data Importer looks for 
the files it reads in this location. 

Help Must be 
local 

The location of the help files used by Macro Space Management. 
 The locally installed files are found at C:\Program 
Files\MSM\Help. 

Note: the directory must be local as chm type help files cannot be 
read across a network for security reasons. 

Log Files Must be 
local 

Log files created by the application to record events and issues. It 
should not be a network directory due to potential file locking 
issues. 

MSM Network Directory that holds standard blocks used by Oracle Retail Macro 
Space Management. It has two sub directories for imperial and for 
metric blocks. 

RFBin Network This holds files that have been marked for deletion in Store 
Manager and moved from the Store Root directory. If purged using 
the option in Store Manager, they will be permanently deleted. If 
un-deleted, the files will be moved back to their location relative to 
the Store Root. 

Planogram 
Publish 

Network Directory which acts as the root for the location planograms are 
published to. The file structure below this root is dependent on 
settings in the Planogram Publishing configuration dialog box 
accessed from the File menu in the Administration Module. 
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Directory 
Name 

Directory 
Type 

Comment 

Planogram 
Root 

Network 
or local 

Root directory for planograms imported from third party software. 
This directory is not used in the standard implementation. 
Planograms can only be imported via the Data Importer 

Root Must be 
local 

Root directory for the application. For files such as the AutoCAD 
line style or hatch style files 

Sounds Network This directory holds .wav files that are used to generate warning or 
alert sounds. It is referenced by ISSC.  

Store Root Network This is the root directory for the directories and files that make up 
the hierarchy specified in Store Manager. As stores, floors, revisions 
and files are added, edited or deleted, the hierarchy below the store 
root will be modified. 
Note: Store Root must be a UNC path if referenced by In-Store 
Space Collaboration. 

Textures Network Directory for Textures. Used for specifying the textures for walls, 
ceilings, etc in Merchandiser 

Working Normally 
local 

Directory for temporary files, including temporary graphics images 
created in Merchandiser. The pre-installed local directory can be 
found at C:\Program Files\Oracle Retail\MSM\Working 

  
More information on specific directories can be found in the chapter on directories. 

Overview of Directory Paths 

General 
Directories may be either System or User Defined. 

 System directories cannot be deleted and can only have their paths changed. 

 User Defined directories are additional to the system directories. They can be added, 
edited and deleted. 

Both are set using the Add Directory or Edit Directory dialogue box from the Directories 
tab of the Configuration module. 

Note: Changing a User Specified directory path will only 
change the path for that user. Changing a Default directory 
path will change that path for ALL users. Accordingly, 
changing the Default directory path should be done with 
caution. 
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Directory Name 
 If the directory is a system directory, the directory name will be grayed out and not 

editable. 

 If the directory is a user defined directory, the directory name can be edited. 

Path Options 
The paths to the directories can take three forms: 

 Mapped drives  

 UNC (Uniform Naming Convention) Paths  

 Local Drives 

Mapped drives and UNC paths are only supported it the appropriate option is checked. 

Location 
Directories can be: 

 Central - on a server, so they are available for all users  

 Local - on a user's hard drive, so they are normally only available to that user 

Note: Take care when specifying directories as local - the 
majority of system directories need to be available to all 
users. 

Central Path 
A central path is a path to a directory on a server 

Local Path 
A local path defines a generic path to a directory on all local drives, for example the help 
file directory that is installed at C:\Oracle Retail\MSM\Help. Each individual 
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installation of MSP must be installed in the same location on their respective computers 
for local paths to be effective. 

Adding, Editing and Deleting Directories 

 

Adding Directories 
Only User Defined directories can be added. This is done by clicking the Add button on 
the Directories tab. This will bring up the Add Directory dialogue box. 

 
This will allow users to configure details for User Defined directories including: 
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 Directory Name 

 Where local or central  

 Path to directory 

Note: The specified path for the directory must reference a 
directory in the Windows directory structure. 

Editing Directories 
Editing directories is carried out by highlighting the required directory in the list of 
directories and clicking the Edit button. What can be edited depends on whether the 
directory is a System or User Defined directory. 

 If a System directory, only the path to the Windows directory can be edited 

 If a User Defined directory, the name the directory is identified by and the path to 
the directory can be edited. 

Note: System Directory names will be grayed out and non-
editable. 

 

If the directory is User Defined, the name used to identify it can be edited. For both 
System and User Defined directories, the path can be set to be either central or local. 

Note: Care should be taken if editing system directory paths 
- changing the path may significantly affect functionality 
within Macro Space Management. Paths to directories are 
referenced by other modules – for example Fixture Studio. 
Changing a path may affect the operation of these modules. 

Deleting Directories 
To delete a User Defined directory, highlight the directory name and then click Delete. 
(System directories cannot be deleted).  A small dialogue box will come up asking for 
confirmation the directory is to be deleted. 
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Click Yes to delete the directory. 

Admin Users and Directory Paths 
Directory paths can only be set when the Configuration Module is opened via the 
Administration module. To set a directory path, highlight a directory and click the Edit 
button. (The Edit button will remain grayed out until a directory has been selected). 

 

This will bring up the Edit Directory dialogue box. 

Central Paths 
Central paths (which must use mapped drives or UNC paths) are used to point to 
directories that are on a server or other centralized resource. They are used for folders 
that are common to all users - for example directories holding images for use in 
Merchandiser. 
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Note: it is generally easier to use UNC paths. If mapped 
drives are used, all computers using the database must have 
their drives mapped to the same point on the server. In 
addition, certain In-Store Space Collaboration features 
require a UNC path to be accessed. 

Local Paths 
Local paths are used to point to directories that are in a common location on hard drives 
across the system. An example would be the help files, which are always located at 
C:\Oracle Retail\MSM\Help in each installation. 
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If the default path is set to C:\Oralce Retail\MSM\Help, then all Macro Space 
Management users will have their software set to look for the help files in that location 
on their local hard drive. 
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4 
Directories 

The Archive Directory 
The Archive Directory is used to hold files that have been processed by Data Importer. If 
the Archive Directory is absent, users will be warned on starting up Data Importer. 

 
Files for Data Importer are initially placed in the Import Directory. When using Data 
Importer, the user can set two options in the Import Definitions dialogue box. 

 
 If the user selects Archive After Import a copy of the processed file will be placed in 

the Archive directory. 

 If the user selects Delete After Import and Archive After Import, a copy of the 
processed file will be placed in the Archive directory and the original will be deleted 
from the Import Directory. 
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The BMP (Bit Map) Directory 
Note: If a version of the software prior to 13.3.2 has been 
installed, it will have been a Windows XP version. The 
default location for installation of the software for Windows 
XP is different from that used for Windows 7 or later 
versions. Accordingly, the path for this directory (if local) 
will need to be updated to reflect the changed location for 
software installation. 

The Bit Map Directory is used to hold the bitmaps used for the Shortcuts folder used to 
access the application. 

 

The Export Directory 
The Export Directory is the specified location to export files to. Objects that can be 
exported include: 

Profiles 
Profiles can be exported by clicking the Export button of the Profiles tab in the 
Configuration module. 

Floor Plans 
Floor plans can be exported from Store Manager by selecting the store plan and then 
using the Export option in the right click menu. This will export the floor plan to the 
Export directory specified in the Directories tab of the Configuration module. 
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The file name will be of the form Store Name_Floor Name_Revision 
Name_Drawing_Name.dwg, enabling the file to be identified. 

Snapshots 
Snapshots are images of the current Merchandiser drawing. They are taken using the 
Snapshot option on the View menu in the Merchandiser module. Snapshots are stored in 
a hierarchy that starts in the image directory that is a sub directory of the export 
directory. A hierarchy will be created below the images directory that mirrors that of the 
store hierarchy. 
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The Floor Plan Publish Directory 
The Floor Plan Publish directory is used as the starting point for the sub-directories used 
to hold published floor plans. The precise structure of those sub-directories will depend 
on setting in the Output Tab on the Floor Plan Publishing Configuration dialog box in the 
Administration Module. 
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The Image Capture Directory 
The Image Capture directory holds the images to be imported into Product Studio and 
subsequently used in Merchandiser (if required) as photographic representations of the 
products on the shelves. The Image Capture directory can either be set to be on a server 
(network) or on the user's hard drive (local). If on a local drive, the images will only be 
available to that user and not generally available for importing. When the image is used, 
whether it is moved or copied to the Image Root directory will depend on the settings in 
the Product Image Configuration dialogue box (called from the View menu).   
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 If the 'Copy file from capture directory to Image Root' option is checked, the image 

will be copied from the Image Capture directory to the appropriate sub-directory in 
the Image Root directory. 

 If the 'Copy file from capture directory to Image Root' option is not checked, the 
image will be moved from the Image Capture directory to the appropriate sub-
directory in the Image Root directory. 

These options affect whether images will remain in the Image capture directory after 
import into Product Studio. 

The Image Label Directory 
The Image Label Directory is used to store images that will be added as labels to fixtures 
in the Merchandiser module. The images can be of .bmp or .jpg type. The images are 
inserted in Merchandiser by using the Add (or Edit) options on the Formatting Toolbar 

 
This will bring up the Labeling dialogue box. 

 

Images that are in the Image Label directory can then be selected from the Image drop 
down list and added to the label on the selected fixture. 
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Note: this functionality is not working correctly at present. 

The Image Profiles Directory 
The Image Profile Directory is used to hold 2D images of planograms. These are 
generated during the planogram design process in the Merchandiser module (example 
below). 

 

These images will be displayed in the Merchandiser module if: 

 The default mode of placing a planogram has been set to '2D' in the Merchandising 
tab of the Configuration module. 

 Planograms have been toggled to '2D' mode using the 'Implode'  option on the 
Directions and Product Text toolbar in the Merchandiser module. 

The Image Root Directory 
The Image Root directory holds sub-directories containing the images assigned to 
products in the Product Studio module and subsequently displayed (when the 
appropriate settings are selected) in Merchandiser. 

Note: In-Store Space Collaboration references the 
information in the Image Root for Front Graphical View. It 
needs the path to be specified in UNC format. 

The names of the sub-directories (and associated images) are dependent on settings in 
the Product Image Configuration dialogue box (called from the View menu in Product 
Studio). 
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Note: Information on directories and filenames is not stored 
in the MSM database. It is implied from the settings in the 
Product Image Configuration dialogue box. Accordingly, 
changing settings in this dialogue box may cause problems 
in locating images imported into Product Studio using 
earlier settings. 

Sub Directory Name 
 SKU Code  

If the SKU code is selected, any value between 0 and 3 can be selected. If 0 is 
selected, all images will be put into the image root without using sub-directories. 
If a value between 1 and 3 is selected, the sub directory will be named after the 
requisite number of characters from the start of the SKU string. 

Note: there is an error in the software. At present the SKU 
code is reading data from the client code field in the 
database, not the SKU field. 

 UPC Code 

If the UPC code is selected, there are two options for determining the name of the 
sub-directories. These are selected via the radio button. 

– If Number of Characters is selected, any value between 0 and 3 can be 
selected. If 0 is selected, all images will be put into the image root without 
using sub-directories. If a value between 1 and 3 is selected, the sub directory 
will be named after the requisite number of characters from the start of the 
UPC string. 

– If Manufacturer is selected, the sub-directory will be named after the first 
five characters of the UPC code as these denote the manufacturer. (Any 
leading zeros will be suppressed). 

 Product Description  

If Product Description is used, the directory name can be anywhere between 0 - 3 
characters long. If 0 is selected, all images will be put into the image root without 
using sub-directories. If a value between 1 and 3 is selected, the sub directory 
will be named after the requisite number of characters from the start of the 
Product Description. 
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Image Name 
 SKU codes or UPC codes 

The image file name for items using either SKU codes or UPC codes will be of the 
same format: Display Style Type/Code/Facing Direction. It is assigned 
automatically when the images are added to the Display Styles dialogue box in 
Product Studio. An example of an image file name would be U50781276_1.jpg. 
The list of Display Style Types is set in the Display Style Types dialogue box 
(accessed from the View menu in Product Studio). 

 

Note: Display Style Types are assigned to specific products 
in the Display Styles dialogue box in the Product Studio 
module. 

The Product Code or SKU code will have been assigned to the product, either 
when it was imported, or when it was added in Product Studio (Display Styles 
dialogue box). The view direction can be one of 6 options: 

Direction Value 

Front _1 

Left _2 

Top _3 

Back _4 

Right _5 

Bottom _6 

There can be up to six images stored for each product display style if UPC or 
SKU codes are in use - only the suffix differing in each file name. 

 Product Description  
If images are being named after the Product description, there can only be one 
image stored per display style. It will be named after the display style 
description; for example Tinned Peas - 50g.jpg. 

The Import Directory 
The Import Directory is used to store files for use by Data Importer. The Data Importer 
module can only read files from this specific directory and cannot be modified to import 
from files in any other location. If the Import Directory is absent, users will warned on 
starting up Data Importer. 
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The Help File Directory 
Note: If a version of the software prior to 13.3.2 has been 
installed, it will have been a Windows XP version. The 
default location for installation of the software for Windows 
XP is different from that used for Windows 7 or later 
versions. Accordingly, the path for this directory (if local) 
will need to be updated to reflect the changed location for 
software installation. 

The Help File Directory contains the .chm (Compiled HTML) files used for the on-line 
help for Macro Space Management. The directory must be local on every user's computer 
as .chm type help files cannot be read across a Microsoft Windows network. The local 
files are found at C:\Oracle Retail\MSM\Help. A typical error from using non-local help 
files is shown below. 

 

The Log Directory 
The Log Directory holds text versions of some of the logs maintained by Macro Space 
Management. 
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This directory may be either local or network. It is recommended it be set to local to 
avoid file lock issues. The log files can be used by Support personnel to diagnose 
problems with the software. 

Note: Other log information is written to tables in the 
database. 

Any log files from ISSC write to a local location on the users computer. This is 
C:\Users\[User Name]\AppData\Local\Oracle Retail\ISSC\Log Files where [User Name] 
is the name of the person logged in to the computer. 

The MSM Directory 
The MSM Directory is the root directory for locally held blocks. It should point at a 
Windows folder called MSMBlocks. 
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The MSMBlocks folder has two further folders as children: Imperial and Metric. These 
hold standard blocks used by Macro Space Management: 

 

These blocks serve a number of purposes in the application: 

 Blocks used for annotating aisles and for bay numbering (i.e. REF-CIRC, REF_ELPS, 
etc) 

 Blocks used to represent modules [2 dimensional blocks used for placing 
merchandise directly on the floor] (I_MODULE) 
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 Product Bocks used to represent products on fixtures (i.e. I_PBASE__, IBOX, etc) 

 Title Blocks used for drawing borders (i .e. ANSI_D, ANSI_E, etc) 

Note: Imperial Blocks have a prefix of I_; metric blocks do 
not have a prefix. 

These blocks can be different file types: 

File Type Description 

DWG File used in the Planner (AutoCAD environment) 

3DS Basic graphics file used in the Merchandiser environment 

LWO Lightwave graphics file used in the Merchandiser environment 

The Planogram Documents Directory 
The Planogram Documents Directory is used to hold reports imported from third party 
planograming software. These reports can be in multiple forms including BMP, JPG and 
PDF files. The name and path of the imported report is displayed in the Associated 
Documents field of the Planogram Design dialog box in the Merchandiser module. 

 

The Planogram Publish Directory 
The Planogram Publish directory is used as the starting point for the sub-directories used 
to hold published planograms. The precise structure of those sub-directories will depend 
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on setting in the Output Tab on the Planogram Publishing Configuration dialog box in 
the Admin Module. 

 

The Planogram Root Directory 
The Planogram Root directory is the folder that holds XML files defining planograms to 
be imported from third party software. These are typically imported into the MSP 
database using a pre-configured form of Oracle Data Importer (ODI).  

The Root Directory 
The Root Directory holds files that are essential to the operation of the software. This 
folder should be set to the local directory where MSM has been installed. The default 
folder is C:\Oracle Retail\MSM 

The RFBin Directory 
The RFBin Directory holds files from Store Manager that have been marked for deletion, 
but not yet purged from the database. When files are marked for deletion in Store 
Manager the physical files and folders are moved from under the Store Root to the 
RFBin. At the same time, the files are renamed. If the files are un-deleted, they will be 
moved back to the Store Root and the name changed back to the file name. If files are 
deleted, all entries will be removed from the database and all physical files and folders 
removed from the Windows folder structure. 
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The Sound Directory 
The Sound Directory is used to hold .wav sound files that can be used to give audible 
warnings for problems within In-Store Space Collaboration. The sounds are not user 
configurable but must be set up by implementers using the Event Sound  table in the 
database. 

The Store Root and its Child Directories 
The Store Root serves as the starting point for a hierarchy of folders containing 
information on the stores within a retail organization. It must be located in a location 
accessible to all users of Macro Space Management and In-Store Space Collaboration. 

Note: In-Store Space Collaboration uses DWF files (a special 
form of an AutoCAD drawing) to show the architectural 
plan for a store. This allows ISSC users to see where the 
fixtures and fittings are located relative to the structure of 
the store. 

Stores, floor and revisions are created relative to the store root. Stores are direct children 
of the store root. Floors are children of their parent stores, and revisions are children of 
their parent floor. 

 

As stores, floor and revisions are created, physical directories are created relative to the 
store root. 
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When the physical directory is being created, it will be named according to the 
information entered in the Store Manager module.  If the store, floor or revision is 
subsequently renamed, it will be renamed in the database only.  The database retains a 
link between the original directory name and the new name assigned in the description, 
so if the floor (or store or revision) is deleted from the database, the physical directory 
will be deleted as well . 

The Textures Directory 
The Textures Directory has two purposes: 

 It holds jpg files used to specify the materials for the floor and ceiling of the store in 
Merchandiser. These materials can be selected for use in the Merchandiser tab of the 
Configuration Module (Floor Material and Ceiling Material options). 
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 It holds jpg files used as the basis for creating lightwave objects (lwo files) for 

fixtures. In the example below a wood grain effect has been used to make a pallet 
more realistic. 

 

Note: A LWO file is a graphics file that gives a more detailed 
image than a 3DS file. The option to set up the LWO file is 
invoked in Merchandiser by right clicking on a Fixture and 
selecting 'Edit Materials'. 

The Working Directory 
The Working Directory should always be local. It stores temporary files used by the 
software. An example would be when products are added in Merchandiser - the 
temporary graphics used to show products as 3D boxes are held in the Working 
directory. 
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5 
The Files Tab 

The Files Tab 
The Files Tab contains information on the location of the AutoCAD template files used 
to create a blank floor plan. It is only available to users who have accessed the 
Configuration Module via the Administration module. 

 

Making Changes 
At present, File information is stored in the registry. Accordingly, in order to change the 
information as to where the files are located, an administrator must log onto each local 
machine in turn and change the information in the Files tab of the Configuration Module. 

File Information 

Prototype Drawing File 
The Prototype Drawing file is the AutoCAD drawing that will be copied each time Store 
Manager is used to create a new drawing. It can be used to specify the default settings in 
the drawing, for example the Snap Grid spacing. There are two Prototype Drawings 
supplied with the software - one for metric and one for imperial drawings. The file 
selected should be appropriate for the units used in the database. Retailers have the 
option of substituting their own prototype drawings. 
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Editing a Path  
To edit a file path, highlight the directory Name then click on the Edit button. This will 
bring up the Select File dialogue box. 

 
Browse to the new directory and click OK. 

Adding a File 
To add a file, click on the Add button. 

 
Type in a name and description for the new file, browse to the new file and click OK. 

Note: there is generally no purpose in adding new files to the 
Files tab - they are not referenced by the software. 

Deleting a File 
To delete a file, highlight the file Name then click on the Delete button. A small dialogue 
box will come up asking for confirmation the directory is to be deleted. 

 
Click on Yes to delete the file 

Note: Mandatory files cannot be deleted. 
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Note: The Prototype drawing files will be found in the 'Data 
Files' directory in the standard installation: C:\Oracle 
Retail\MSM\Data Files. 

The Focus.lin File 
If users have had an earlier installation than 13.3.2, the database will contain reference to 
a Focus.lin file. This file is no longer required but unless the path is removed, a message 
will appear concerning it each time the Configuration Module is closed. To correct the 
problem: 

1. Highlight Line in the list of files. 

2. Click Edit.  

3. Delete all information from the File field in the Select File dialog box. 

4. Click OK 

 
The Configuration module will then close without a message concerning the Focus.lin 
file. 
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6 
The Zones Tab 

The Zones Tab 
The Zones Tab contains basic options for Zones. It is available from the Administration, 
Fixture Studio, Product Studio, Planner or Merchandiser modules. If opened from the 
Fixture Studio, Product Studio, Planner or Merchandiser modules only a restricted set of 
tabs will be available (shown below). 

 

The options are as follows: 

Option Description 

Auto Close  This will automatically close a zone when drawing it if the user clicks within the 
specified Proximity (distance) of the point where drawing the zone commenced. 

Proximity This is the distance the uses to click within relative for the origin of the zone to close 
the zone if Auto close has been selected. 

Hatch 
Zones 

This determines whether different zone types are drawn with a fill pattern or 
transparent background when added to a floor plan. 

Hatch Over 
Text This determines whether the Hatch Pattern will go over the top of any annotation. 

Detect 
Clashes 

This determines whether clashes between overlapping zones are highlighted during 
Zone placement. Only Zones on the same aliased layer can be shown as clashing. 
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Option Description 

Prompt for 
Name 

This will cause a dialogue to come up allowing the zone be renamed locally when 
inserted into the floor plan. 

Thicken 
Boundary 

This is a highlighting option. If selected, the boundary of the zone in a floor plan will 
thicken when highlighted via the Highlight in Drawing option on the zones tool bar 
display of the Object Browser display. Thicken only affects floor plans opened in the 
AutoCAD environment, not in Merchandiser. 

Flash  

This is a highlighting option. If selected, the boundary of the zone in a floor plan will 
flash on and off when highlighted via the Highlight in Drawing option on the zones 
tool bar display of the Object Browser display. Flash only affects floor plans opened in 
the AutoCAD environment, not in Merchandiser. 

Zoom 

This determines whether a Zone increases in apparent size when selected. The 
physical size of the Zone does not change, only the scale it is displayed on the screen. 
Zoom only affects floor plans opened in the AutoCAD environment, not in 
Merchandiser. 

Max Zoom 
Scale  

This is only active when the Zoom check box is ticked. It sets the amount a zone 
zooms when selected. 
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7 
The Fixturing Tab 

The Fixturing Tab 
The Fixturing Tab contains a series of options primarily concerned with fixture 
placement. These options can affect how fixturing behaves in Planner, Merchandiser or 
both. It is available from the Admin, Fixture Studio, Product Studio, Planner or 
Merchandiser modules. If opened from the Fixture Studio, Product Studio, Planner or 
Merchandiser modules only a restricted set of tabs will be available (shown below). 

 

The purposes of the different parts of the dialog box are as follows: 

Frame Purpose 

Attributes 
Frame 

This specifies which how any attributes (information) associated with the fixture or 
fitting behave when it is placed into the floor plan in AutoCAD. 

Placement 
Frame 

This specifies which options are available when a fixture or fitting is placed into a 
floor plan in Planner. For example, the drop down list in the Placement frame and 
the Auto Rotate and Auto Reinsert options govern the initial behavior of the Add 
Fixture dialog box. 

Connection 
Points Frame 

This specifies a series of options that determine how two fixtures/fittings with 
connection points join together in the Planner and Merchandiser modules. For 
example in the Merchandiser module, if the Size Filter option is selected, connection 
points must have the same or overlapping sizes to connect. 

 Highlighting 
Frame 

This determines how fixtures or fittings highlighted  via the Highlight in Drawing 
option on the Fixtures tool bar display of the Object Browser display. 
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Preview 
Frame 

This determines how Fixtures and Fittings will show in the Preview window on the 
Object Browser. 

Tooltip 
Frame 

This determines the information that will show when the mouse pointer is held over 
the fixture/fitting name in the Object Browser hierarchy. 

The Attributes Frame 
The Attributes Frame is used to set the options available for AutoCAD attributes 
assigned to an AutoCAD Block. These settings will take effect when blocks are inserted 
in the Planner module. 

 

Note: Attributes are customizable annotations specific to 
particular types of object, for example fixtures. They are 
typically assigned to an  object using the AutoCAD ATTDEF 
command - generally before the block is registered in Fixture 
Studio. For more information on Attributes and Blocks see 
the AutoCAD help files. 

In the example below, the attribute is used to specify the material for the fixture. 
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Resize Attributes results in the attribute being resized if the size of the object to which 
the attribute is attached changes. This applies to stretchable (re-sizable) blocks where the 
user can specify dimensions when the block is placed in the drawing. If this option is not 
checked then the attribute will stay the same size when the size of the object is changed. 

Rotate Attributes results in the attribute being rotated to stay in a readable orientation 
when the object to which the attribute is assigned is changed to another orientation. If 
this option is checked, the attribute will be ' flipped' so that it can be read when the block 
is rotated 180o. If the option is not checked, the attribute will appear upside down when 
rotated 180o. In the example below the Rotate Attributes checkbox has not  been checked. 
When the block is placed in the Planner module and rotated 180o, the attribute text is 
upside down. 

 
Prompt for Attributes results in the user being prompted to edit the attribute when the 
object is inserted. The prompt will appear in the AutoCAD command line in the Planner 
module. 

 

Note: If the Prompt for Attributes option is checked, the user 
will have to specify an attribute before the Add Fixtures 
dialogue box appears. 

The Placement Frame 
The Placement Frame is used to specify how fixtures place in the drawing. Some options 
apply to the Planner module, some to both the Planner and Merchandiser modules. Some 
of these options (such as the UCS icon option) will only take effect when Planner  has 
closed and reopened. 
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The options are either selected from the drop down list, selecting or deselecting the check 
boxes, or by using the spin controls. 

The drop-down list at the top of the frame gives the user the option to set the default for 
the Add Fixture dialogue box in the Planner module. 

 Auto Attach enables the fixture being inserted to be snapped to an existing fixture 
(providing suitable connection points exist). 

 Auto Move enables the fixture to be moved to a different position than the original 
insertion point. 

 Auto Align automatically aligns the fixture being inserted with the nearest existing 
fixture. 

  

 
 Auto Rotate automatically requires the user to specify the rotation angle of the block 

when inserting into the drawing. 

 Auto Reinsert enables the user to insert further examples of the fixture without re-
selecting it from the hierarchy by pressing <Return>. 
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If either Auto Rotate or Auto Reinsert is selected, this will render some of the options 
in the Add Fixture dialogue box temporarily unavailable. 

 
The unavailable options are Place Fixture In-Line, Offset the Fixture, Array Fixtures, 
and Rotate Fixture. Undo is also temporarily unavailable because there are no actions 
to undo until the fixture has been placed. 

 Explode Composites results in composite blocks separating into their constituent 
parts when inserted into the drawing. 

Note: This option is an MSM command and differs from the 
AutoCAD Explode command. The AutoCAD Explode 
command will explode the composite into its constituent 
parts, but will not write the individual blocks into the MSM 
database. This requires synchronization - depending on the 
setting this may be manual or done automatically by 
Dynamic Sync.. The MSM Explode command both explodes 
the composite into its constituent blocks and writes the 
individual blocks into the MSM database - synchronization 
is not needed. 

 Display UCS Icon determines whether the Planner UCS (Universal Coordinate 
System) icon is displayed when fixtures are inserted. If the box is not checked, the 
UCS icon will be temporarily suppressed while a fixture is being placed. 

 Prompt for Sizes activates a dialogue box that prompts the user to specify the 
dimensions for stretchable fixtures. If checked, if a stretchable fixture is placed, it will 
cause a prompt dialogue box to appear. 

 

Note: if the Prompt for Sizes checkbox is not selected, it will 
not be possible to specify the size of stretchable fixtures 
when inserting them in the drawing - instead the default 
values will be used. Stretchable blocks can be resized after 
placement. 

 Angle increments set the increments by which a fixture can be rotated during 
insertion into Planner. 
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Clicking on the Rotate Fixture option in the Add Fixture dialogue box will bring up 
the Rotate Block dialogue box. 

 
The Angle Increments option in the Fixturing tab of the Configuration Module 
determines the increments the Relative angle will increase or decrease when the spin 
controls for Relative Angle are used. 

 Size Increments sets the increments by which a fixture can be nudged during 
insertion. 

Note: this functionality is not working at present. 

 Fixture Nudge Increment sets the amount a selected fixture is nudged in the 
Merchandiser module each time a cursor key is pressed. If set to 1 in an imperial 
database, then the fixture will be moved the equivalent of one inch every time a 
cursor key is pressed. (The equivalent would be one millimeter in a metric database). 

 Snap Radius determines how close a fixture has to be to another in the Planner 
Module before the connection points snap together. The larger the value, the greater 
the distance one fixture will snap to another from. 

Note: For fixtures to connect together, their connection 
points must have compatible settings. See Fixture Studio 
help file for more detailed information. 

The Connection Points Frame 
The Connection Points frame is used to specify details of connection points that join one 
fixture to another. The connection points themselves are configured in the Block Details 
dialog box in Fixture Studio. 
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The options are either selected by selecting or deselecting the check boxes, or by using 
the spin controls. 

 Gender Filter sets whether male connections can only connect to female connections, 
or whether one connection can connect to another irrespective of gender. If off; any 
gender will connect to any gender. 

 Size Filter sets whether connections have to be of compatible sizes to connect, or 
whether one connection can join to another irrespective of size. If off, any size of 
connection will connect to any other size. 

 Shape Filter sets whether connections have to be the same shape to connect. If off, 
any shape will connect to any other shape. 

Which filters are set will determine which connection points can connect to which - and 
which warnings display. In Merchandiser, if the connection points are incompatible, a 
warning will be given in the status bar.  

 
Pointer Size is used to set the size the connection points visually appear in the Planner, 
Merchandiser and Fixture Studio environments. 

 In Planner, the connection points will appear when the 'Attach' option is selected in 
the Add Fixture dialogue Box. 

 In Merchandiser, the connection points will appear when Connections are toggled 
On in the status bar and a fixture is selected. 

 In Fixture Studio, the connection points can be seen in the Preview Tab of the Block 
Details dialogue box - tick the 'Connection Points' check box to display them. 
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Line Size is used to set the thickness of lines associated with connection lines in the 
Merchandiser module and in the Preview Tab of the Block Details dialogue box - tick the 
'Connection Points' check box to display them. 

Colors are used to set the color for the connection points used in the Planner and 
Merchandiser environment. 

Note: It is recommended Neutral, Male and Female 
connection points are given different colors. 

The Highlighting Frame 
The Highlighting frame has two functions: 

 It is used to specify how fixtures appear when highlighted in the drawings in the 
Planner module. 

 It is used to specify the color of the merchandisable area in Merchandiser and Fixture 
Studio 

 
The option is activated in Planner by clicking the Highlight in Drawing option in the 
Fixturing toolbar - when a fixture present in the floor plan is highlighted in the fixture 
hierarchy it will be highlighted in the drawing according to the selected options. 

 
 Flash causes the selected Fixture to flash three times when selected from the 

hierarchical tree. 
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 Thicken increases the thickness of the lines denoting the fixture as visible on the 
drawing.  

Note: For this option to work, the fixture must have been 
created with the AutoCAD line weight set to BYBLOCK. 

 Zoom determines how much a fixture is zoomed in on when selected. The physical 
size of the Fixture does not change, only the scale it is displayed on the screen. If 
there are multiple fixtures in the drawing, the drawing will zoom until all fixtures of 
that type are visible. 

 Max Zoom Scale is only active when the Zoom check box is ticked. It sets the amount 
a fixture zooms when selected. 

 Merchandisable Area Color indicates the color merchandisable areas appear in the 
Preview Tab of Fixture Studio and if displayed in the Merchandiser module. In the 
example below from Fixture Studio, the Merchandisable area color has been set to 
gray. 

 

The Preview Frame 
The Preview frame is used to set the order of priority that previews will display in the 
preview window in the Object Browser in the Merchandiser module. 
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Each option in the list of those available can be moved up and down in the window by 
clicking on the Up or Down buttons. If a direction is not available then the appropriate 
movement button will be grayed out. The screen shot below shows the thumbnail option 
in use on the Object Browser. 



 The Tooltip Frame 

 The Fixturing Tab 53 
 

 

The Tooltip Frame 
The Tooltip Frame is used to select the tooltip that is displayed when the mouse pointer 
is held over a fixture. 
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The required tooltip can be selected by using the scroll bar to find the required tooltip in 
the list of those available, then clicking on it to highlight it. 
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The Merchandising Tab 

The Merchandising Tab 
The Merchandising Tab contains setting that affect how Products and Planograms are 
placed on fixtures. It is available from the Admin, Fixture Studio, Product Studio, 
Planner or Merchandiser modules. If opened from the Fixture Studio, Product Studio, 
Planner or Merchandiser modules only a restricted set of tabs will be available (shown 
below). 

 

The options are as follows: 

Option Description 

Selection 
Frame 

This specifies a series of options determining how fixtures are selected for 
placement of Products or Planograms. 

Options 
Frame 

This determines what tolerances will be allowed for over or undersize planograms 
when placing them – planograms outside these tolerances will trigger an error 
message. This functionality is not currently active. 

Highlight 
frame 

This specifies how selected fixtures will display in the Planner module when the 
Highlight in Drawing option is used. 

Check Rules 
Frame This specifies the warnings that will be given during planogram placement. 

Placement 
Rules frame  

The Detail drop down list specifies the form the planogram will be placed in the 
Merchandiser module. The other options are not currently active.  
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The Selection Frame 
The Selection frame specifies a series of options determining how fixtures are selected 
for placement of Products or Planograms. 

Note: Changes in these settings will have a considerable 
effect on how fixtures are selected. Users may wish to 
experiment to find settings that suit their requirements. 

 
 Fixture Selection Mode is selected from a drop down list. It only affects the Planner 

module. 

– Standard Selection allows users to use all the usual AutoCAD selection methods, 
for example windows selection boxes and fences. 

– Pick Near Position gives an different selection method. Providing no fixtures are 
currently selected, when the Add Product or Add Planogram buttons are clicked 
on the Object Browser, users may select fixtures to merchandise by clicking 
adjacent to them. A sequence of fixtures may be selected, the selection sequence 
being completed by right clicking. 

 Vertical Category Filter enables the user to select Planograms that have previously 
been assigned to a vertical category. This allows users to select planograms that have 
been designated for placement in fixtures above floor level. 

Note: This functionality is not fully implemented 

 Proximity Check sets the tolerance for the Planner cursor when Standard selection is 
in use. The larger the value; the further the user may click from a fixture and still 
select it. 

 Always show selection dialogue controls display of the Delete Products dialogue box 
when products or planograms are deleted in the Planner module. 

– If this option is not enabled, then the dialogue box will only appear if multiple 
products or planograms are selected. Single instances of a product or planogram 
will be deleted without further confirmation.   

– If this option is enabled, then the dialogue will appear even if a single product or 
planogram is deleted. 
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 Select whole planogram allows users to select a single fixture associated with a multi-

bay planogram and delete the whole planogram when the Delete Planogram 
command is used. 

 Highlight selected fixtures highlights fixtures in the drawing suitable for the 
currently selected planogram in the Object Browser. 

Note: This functionality is not currently active. 

 Sort Left-most controls whether fixtures are populated in the sequence they are 
selected or whether they are sorted into a sequence starting with the leftmost fixture. 

– If Soft Leftmost is Off, then the fixtures will be populated in the sequence they 
are selected. 

– If Sort Leftmost is On, then the fixtures will be populated leftmost first relative to 
the front of the fixtures. 

In the diagram below, the effects can be seen of having Sort Leftmost Off and On. The 
effect of front direction can also be seen. 
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Product Tooltip specifies the type of tooltip to be displayed when a mouse cursor is 
hovered over a product in a Planner or Merchandiser Store Plan. 

 

The Options Frame 
The Options frame determines what tolerances will be allowed for planogram length 
when placing them onto fixtures before a warning is generated. It functions for both 
Planner and Merchandiser. 
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The tolerances can be set to 0 - 50% for fixtures that are both Over and Undersize for 
length relative to the selected planogram. This option is not currently active. Product 
Nudge Increment sets the amount a product is nudged in Merchandiser each time a 
cursor key is pressed. If set to 1 in an imperial database, then the product will be moved 
the equivalent of one inch every time a cursor key is pressed. The equivalent would be 
one millimeter in a metric database. There is no effect in the Planner environment). 

The Highlight Frame 
The Highlight frame specifies how selected merchandise will display in the Planner 
Module. 
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The option is activated in Planner by clicking the Highlight in Drawing option in the 
Merchandising toolbar in the Object Browser - when a product or planogram present in 
the drawing is highlighted in the fixture hierarchy it will be highlighted in the drawing 
according to the selected options. 

 
 Flash causes the selected merchandise to flash three times when selected from the 

hierarchical tree. 

 Zoom causes the view to zoom in on the merchandise when selected. The physical 
size of the Fixture does not change, only the scale it is displayed on the screen. If 
there are multiple fixtures in the drawing, the drawing will zoom until all fixtures of 
that type are visible. 

 Max Zoom Scale is only active when the Zoom check box is ticked. It sets the amount 
an item of merchandise zooms when selected. 

The Check Rules Frame 
The Check Rules Frame sets criteria by which warnings will be given for Planograms 
being placed in both the Planner and Merchandiser modules. 
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When a planogram is designed in Merchandiser or imported into the MSM database, the 
planogram definition contains information about the fixtures it is designed to be placed 
on. The check rules compare information on the fixtures selected in the drawing with the 
information on fixtures held in the planogram definition. If there is a difference between 
the selected fixtures and the defined fixtures for the currently active rules, a Planogram 
Placement Errors dialogue box will appear in both Merchandiser and Planner 
environment. 

 
The check boxes generate the following warnings if selected: 

 Size is currently grayed out.  

 Planogram Length, Planogram Depth and Planogram Height trigger warnings if the 
selected fixtures do not match the sizes specified in the planogram definition  

 Range triggers a warning if the Planogram to be added has properties that do not fall 
within a specified temperature range. 

Note: The weight range option is currently not active. 

 Style triggers a warning if the Planogram to be added has a specified style that does 
not match one of the assigned styles for the specified fixtures. 
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 Allow Multiple Profiling allows the user to add a planogram to a fixture already 
containing merchandise if the checkbox is ticked. 

Note: To be warned about multiple profiling, ensure this 
checkbox is NOT checked. 

 Split Planograms triggers a warning if a planogram has been placed on fixtures that 
are not adjacent - i.e. fixtures with  a distinct gap between them and the planogram 
has not been designated as splittable. 

Note: This warning does not currently operate in 
Merchandiser - although it does in the Planner module. 

The Placement Rules Frame 
The Placement Rules frame determines how the planogram will be placed on the 
selected fixtures. Some options cater for if the parameters in the planogram definition 
differ from those of the selected fixtures. 

 
 Detail brings up a pull down list specifying the default level of detail the planogram 

will be drawn in. 

 

– 2D places a simple placeholder to represent the planogram. No shelves or 
products will be drawn. 

– 3D draws the shelves in the planograms but represents the products by 
placeholders on the individual shelves. 

– 3D with Product Items shows the shelves with individual products drawn. 
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Note: The Detail drop down list sets the amount of default 
level of detail planograms will be placed in. It is possible to 
change the level of detail in an individual store plan in the 
Merchandiser module by clicking on the Implode or Explode 
icons in the Directions and Product Text Toolbar.  

 
The remaining options determine what happens if the fixtures selected to place the 
planogram on differ from those specified in the planogram definition held in the 
database. 

 The Extend if fixture is longer option comes into effect when planograms are shorter 
than the fixture. The two subsidiary options will be grayed out until the 'Extend if 
fixture is longer'  option is selected. 

– Extend Shelves increases the shelf length (and depth) on the planogram until i t 
matches that of the fixture. 

– Fill with product puts additional product onto the shelf (or fixture) for the 
additional length (and depth) of the fixture. 

 Truncate will shorten the Planogram length to that of the fixture if i t is longer. This 
means that both the shelves and their associated products will be reduced for both 
length and depth as required. 

 Nearest Slot will change the slot heights in the Planogram to match that of the fixture 
if the fixture does not permit the slot heights specified in the Planogram. 

 Nearest Shelf Angle will change the shelf angles in the Planogram to match those of 
the fixture if the fixture does not permit the shelf angle specified in the Planogram. 

Note: the functionality for extending and truncating 
planograms is not yet fully implemented. 
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9 
The Merchandiser Tab 

The Merchandiser Tab 
The Merchandiser Tab  contains a series of options determining how things are 
displayed in the Merchandiser module. It is available from the Admin, Fixture Studio, 
Product Studio, Planner or Merchandiser modules. If opened from the Fixture Studio, 
Product Studio, Planner or Merchandiser modules only a restricted set of tabs will be 
available (shown below). 

 

Render Mode 
This functionality is currently not enabled.  

Product Representation 
This sets the default way display styles are represented in the Merchandiser module. 

Express Load 
This option allows users to only load part of a Store Plan, thus maximizing operation 
speed while working in the Store Plan. If selected, the Express Load dialog box will 
appear when opening a Merchandiser floor plan, enabling the user to select what is 
displayed.    
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Double Sided 
This option allows for objects drawn in Planner (AutoCAD) that might have only had 
one face assigned to a side. Checking Double Sided ensures that both faces of such 
objects are drawn - although at a penalty in performance.  

Lock on Tab Change 
Lock on Tab Change links current setting of the Object Browser in the Merchandiser 
Module to actions that can be carried out in the current store plan. If set to 'On' then 
fixtures and gondolas are locked against change except when the Fixturing Tab is 
selected. Similarly, products and planograms are locked against change except when the 
Merchandising Tab is selected. 

Texture Quality 
Texture Quality sets the default Texture Quality for when a drawing is opened. The 
texture quality for a specific store plan can be adjusted using the toolbar options in 
Merchandiser. 

Ambient Light 
The Ambient Light sets the default light level for the floor plan. If Lights (Light Menu) 
have been added to a floor plan, the highlighting effect for those lights will remain, but 
the overall light level will be changed. 

Front Clipping Distance and Back Clipping Distance 
The Front Clipping Distance and Back Clipping Distance set the maximum and 
minimum distances the drawing will be visible within. These values can be reset for a 
specific store plan can be adjusted using the toolbar options in Merchandiser. These 
setting can be used to aid performance by reducing the amount of the floor plan that is 
drawn.  

Fixture Snap 
This functionality is not enabled at present. 

Product Snap 
This functionality is not enabled at present. 

Floor Material 
This enables the user to select a jpg or.bmp graphics file that will appear at repeated 
intervals to represent the floor in each store. These files must be located in the Textures 
directory specified in the Directories tab of the Configuration module.  

Ceiling Material 
This enables the user to select a jpg or .bmp graphics file that will appear at repeated 
intervals to represent the ceiling in each store. These files must be located in the Textures 
directory specified in the Directories tab of the Configuration module.   

Wall Material 
This functionality is not enabled at present. 
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Floor Texture Size 
This is the size that the image for the floor (and ceiling) will be drawn. The image will tile 
repetitively at that size. 

Sky Color 
This is the color that the sky will draw in the Merchandiser environment. It can be 
selected by clicking the button and selecting the color from the pallet. 

Ground Color 
This is the color that the ground will draw in the Merchandiser environment. It can be 
selected by clicking the button and selecting the color from the pallet. 

Note: This functionality is not enabled at present. 

The Express Load Option 
The Express Load option  on the Merchandiser tab allows selection of specified parts of 
the store plan to be displayed. This speeds up movement and operations within the 
drawing as a smaller quantity of data is being manipulated. It is selected by ticking the 
check box on the Merchandiser tab. 

 
When a store plan is selected in Merchandiser, the Express Load dialog box will appear. 
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This gives control over what is displayed. For any selected zone, the user can opt to 
display: 

 Fixtures  

 Fixtures and Shelves  

 Fixtures, Shelves and Products 

On clicking OK, the store plan will open with only the selected zones displayed. 

The Double Sided Option 
The Double Sided option allows for objects drawn in Planner (AutoCAD) that might 
have only had one face assigned to a side. Checking Double Sided ensures that both faces 
of such objects are drawn. 
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To understand this, consider this example of products placed inside a bin. The Front 
Clipping Plane has been advanced until i t cuts into the image. The products are drawn in 
the form of a cube but only the outside faces of the cube are normally drawn. Here, use of 
the Front Clipping Plane has revealed the inside faces of the cube - which have been 
drawn without any detail. 

 
The software usually correctly determines what the outside and inside faces of an object 
are. Sometimes there will be an error. For example, the outside [normally visible] faces 
could be drawn without detail and be invisible to users. In the example below, the left 
hand image shows the 'double sided' option set to Off, with some faces of the fixture not 
being rendered correctly. The right hand image shows the 'double sided' option set to 
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On, with all faces of the fixture drawn double sided, thus avoiding the error. However, 
because more faces are being rendered, this requires more processing capacity from the 
computer. 

 

The setting for the 'Double Sided' option is saved to the Registry and is thus specific to 
individual computers. It is recommended that users set 'Double Sided' to Off unless there 
are problems rendering objects in a specific store plan. 'Double Sided'  can then be set to 
On - once Merchandiser has been restarted objects will draw fully in that store plan. 

Note: The AutoCAD Rendering Preferences Option dialog 
box provides a similar option called 'Force 2-sided' for the 
Planner Module. This can be accessed by using the 'RPREF' 
command in the command line. 
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Front and Back Clipping Distance 
The Front Clipping Plane and Back Clipping Plane are used to set the front and back 
distances beyond which detail is not visible. Reducing the area that is drawn in the store 
plan improve the performance in rendering the drawing. 

Front Clipping Plane 
The Front Clipping Plane determines the distance in front of the user's view point detail 
will start being drawn from. In the left hand image the Front Clipping Plane is in front of 
the fixtures being viewed. In the right hand image, the Front Clipping Plane distance has 
been increased. It has now reached the products on the top shelf of the end cap. Parts of 
those products are inside the Front Clipping Plane and will not be drawn.  This option 
can be used to make foreground fixtures invisible, allowing users to see what is behind 
them. 
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Back Clipping Plane 
The Back Clipping Plane determines the maximum distance from the user's view point 
detail will start being drawn from. In the example below, the Back Clipping Plane is 
behind the fixtures and all of the fixtures are visible. 

 

In the example below, the Back Clipping Plane has been brought closer and fixtures 
further to the rear are no longer included in the view being drawn. 
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Floor and Ceiling Materials 
Floor and Ceiling Materials can be assigned, allowing the store to look more realistic. In 
the example below, a tile material has been assigned to the floor. 

 
Floor and Ceiling materials are assigned by clicking on the appropriate button in the 
Merchandiser tab and navigating to the required image. 
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Note: valid image types are .jpg and .bmp 

The size the image will appear is governed by the Floor Texture size. If set to 8" x 4" the 
image will tile repetitively a t this size. 

Ceiling Height 
The ceiling will draw at the height specified in the Level Type table in the database. In 
the example below, the ceiling is set to draw at a height of 168" (14ft). 

 
The ceiling is visible when viewed from below, but not when viewed from above. 
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The Profiles Tab 

Overview of Profiles 
The Configuration Module allows users to specify a large number of local settings to suit 
their preferences as to how their local copy of the software should operate. These settings 
are stored in Profiles. The user can define multiple profiles and readily switch between 
them - thus changing from one configuration of the software to another. This is done via 
the Profiles Tab. 

 

The Profiles Tab and the Registry 
Settings from the Configuration Module are stored in the Registries of individual 
computers. In order to change the information as to which database a specific machine 
should connect to, an administrator must log onto each machine in turn and change the 
information using the Database Configuration tool located in the C:\Oracle 
Retail\MSM\Common.Net windows folder. The information will be stored in the currently 
active profile. If multiple profiles exist, users can switch from one database connection to 
another by making different profiles current. 

Note: Some of these values are stored as bit wise variables - 
these should be set through the Configuration module and 
not directly in the registry. 
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The Profiles Tab 
Each Profile contains a defined set of preferences that have been set using the 
Configuration Module. The Profile in use is known as the Current profile. As changes are 
made to the Configuration Module, the modifications are stored in the current profile. 
Oracle Retail Macro Space Management allows users to store multiple profiles, allowing 
them to switch from one set of standard settings to another. 

 
All currently available profiles will be listed in the text pane. 

Set Current makes a highlighted profile current. 

Note: the new profile will not take effect until the software 
has been closed and restarted. 

Add takes a copy of the current profile and stores it under a different name. It also makes 
the new profile current. (To rename the profile, highlight it and use the Rename option 
on the right click menu). 

Delete deletes the highlighted profile. 

Note: If the profile to be deleted is current, it cannot be 
deleted – another profile has to be set to current first. 

 
Before the profile can be deleted, it has to be confirmed via a dialogue box. 
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Export Profile exports the highlighted profile to the Export directory, putting up a 
confirmatory message at the same time. 

 

Note: The Export directory is specified in the directories tab. 

Switching Profiles 
Each Profile holds a complete user specific list of settings for Macro Space Planning. This 
allows users to swap from one list of settings to another at the click of a button. An 
example would be switching from a test environment to a live environment. In order to 
do this, highlight the profile it is wished to change to and click the Set Current button. 
The new profile will not take effect until the software has been closed and restarted. 
Accordingly it is best to switch profiles with just the Administration module open. The 
Administration module can then be closed. When restarted, the user will be connected to 
the new database. 
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